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President’s Corner - Bruce Livingston 

With so much happening this time of year, 
wildflowers blooming, spring migration of 
shorebirds and waterfowl, and the return of 
warmer (and hopefully drier) weather, the op-
portunities to get out and photograph are am-
ple. 
 
I want to take this time to focus on some very 
important upcoming events for the Club. June 
27th at 6:00pm is our Annual Banquet at Riv-
ers Edge Restaurant in Tumwater. Along with 
all the fun image sharing and Scavenger Hunt, 
we will be holding elections for Club Officers 
for the upcoming year. This year’s nominating 
committee consists of Rosalind Phillips, Scott Wood, Linda Foss and me. We will be look-
ing to prepare a slate of candidates for the board. If you are interested in serving the club 
in any capacity (including serving on committees like the Field Trip, Fundamentals Group 
or Advanced Group) please contact one of us on the Nominating Committee and let us 
know in what capacity you would like to volunteer. 
 
The other activity that I want to remind everyone about is the Thurston County Fair, which 
is coming up in August from Aug. 2 to the 6th. The Club sponsors the Open Photography 
Exhibit and we will need volunteers to help with intake, display and take-down of photo-
graphs and display boards. We also have a Camera Club table where we inform Fair goers 
about the Club. Dale Easley will be bringing sign-up sheets for volunteers to help with 
these functions at our upcoming meetings.  
 
Look for articles in this newsletter for more details on both these events, and, as al-
ways.......take some time to get out and shoot.  
 

Bruce 

Note from the Editor: 

I hope you are as excited as I am about the new format of the newsletter. I am en-

joying the learning process and my brain is in high gear thinking about what infor-

mation and articles might be of interest to you. As you can see the newsletter al-

most doubled in number of pages this month, but I think you will find a wealth of 

information. I would like to thank those who have been willing to write articles and 

share images for the newsletter. I always need images of any kind (nothing obscene 

or nude bodies please) and articles, technical tips, new places to explore, etc. The 

one thing I would ask you to please do if you submit images is to watermark them. 

Unfortunately there are images in this newsletter not watermarked. It is far too time 

consuming for me to ID the photographer on images not watermarked. 

 Please send all submissions to newsletter@olympiacameraclub.org. 

Pam Hoaglund 
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Monthly Meetings 

All meetings are held at 
 

Capital High School, Pod A 
2707 Conger Ave NW 
Olympia, WA 98502 

 

Digital Imaging Group 
May 8, 2017 

7 pm  
Meets in Digital Communication Lab 

 
This month we have a professional framer (Pam Giovannini) coming to discuss framing and mounting photos. I spe-

cifically wanted her to discuss mounting because it's about time to think about entering photos in the Thurston County 

Fair, The Southwest Washington Fair, The Fair (Puyallup), and probably others I don't know about. While I don't 

have all the rules for each one (The Fair is probably the most restrictive), generally foam core is best. I've used Pam 

for years and I know at least a couple other Camera Club members who have had work done by her for the fairs. 

 
John Gerecht, Coordinator     

 

Fundamentals of Photography Group 
May 9, 2017 

7-9 pm 
 

Meeting Topic:  Application of Basic Skills When Photographing Cars, Birds, Flowers, Dogs, Cats and Horses  

Five of the many talented members of our camera club are going share their stories about how they learned to "get it 

right" out of the camera when photographing these specific subjects: cars, dogs and cats, birds, flowers and horses. 

The images shown will have been taken with a variety of camera types, demonstrating that good photography is not 

dependent on owning high end equipment.  The emphasis is going to be on the application of basic skills with the 

camera itself, not post processing. The presenters will tell us how they set the parts of the exposure triangle and why, 

as well as what made him or her choose the type of lighting, perspective, composition and focus used. Hopefully we'll 

all get some tips on how to improve our own images in the subject areas covered.   

 
We hope you'll attend a meeting to see if it fits your needs!                Judy Mason, Coordinator 
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Advanced Meeting 
May 16, 2017 

7-9 pm 
 

Over the last few years the term “critique” has taken on a somewhat negative meaning, which is unfortunate as honest 
critique is a cornerstone in developing as a photographer, both 
artistically as well as technically. 
For our May Advanced Photography Group meeting we are go-
ing to take a deep dive into what a photo critique is, what is 
should be, and how it can help all of us grow as photographers.  
We will discuss reasons why the term “critique” might have 
taken on such a negative vibe since the huge growth of digital 
photography.  We will see what goes into a positive critique 
session as well as address what elements of an image are gener-
ally critiqued.  Hopefully by the end of the session everyone 
will have a better understanding of what a photo critique is, and 
will walk away knowing that it can be a great tool to take your 
photography to the next level. 
I am asking those that are willing to bring an image for critique 
at the end of the evening where we will put into practice what we addressed during the session.  Feel free to bring 
either a digital image or a print.  Please keep in mind that while the projection of a digital image allows for a much 
larger display, you do lose some control over the way that the brightness, color and contrast are presented. 

 
Scott Wood, Coordinator 

 General Meeting 
May 23, 2017 

7-9 pm 
 
It might seem hard to believe, but summer is right around the corner. With all the rain we have had it really does feel 
like we skipped spring altogether, but with summer comes fair season.  With fair season quickly approaching, for our 
General Meeting this month we are going to explore our club’s participation in the Thurston County Fair. 
We will start our evening off with Dale Easley, the OCC Fair Coordinator, discussing what the club’s official in-
volvement is with the fair, what the guidelines are for entering the fair as well as discussing how our members can 
help during fair week. 
After Dale’s presentation, we will dig a little deeper into what it takes to enter the fair, how to select images to enter 
as well as some “best practices” for the images that you do enter. 
I will be bringing prints that I have entered into the fair over the last few years, and if you have prints that you have 

entered I am sure that everyone would like to see those as well.  
If you do bring prints though, please insure that they are the ac-
tual prints, with any associated awards you may have received, 
as this is not a general photo sharing session. 
As a final bit of housekeeping, our clubs travelling prints have 
made their way back to Olympia and we will be presenting the 
images that will be moving on to the NWCCC show this fall for 
final judging.  For those that are not going forward this will be 
the first opportunity for you to pick your prints up. 

 
Scott Wood, Coordinator 
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Bottle Beach Shorebird Trip Report 
by Bruce Livingston 

 
The April field trip to Bottle Beach was a great time. By my tally, 

twenty five camera club members, family and friends packed up 

cameras, boots and rain gear and drove to the Westport Winery for 

lunch. After a very nice lunch we drove the short distance to Bottle 

Beach. The weather cooperated during the early part of our trip, but 

as the tide got higher and the birds got tantalizingly closer, the 

weather started to change from light sprinkles to a steady rain. 

Those who braved the rain until just before high tide were treated 

to some amazing opportunities to photograph shorebirds up close 

and personal.  
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Mima Mounds Field Trip 
20 May 2017 

 
 May 20th is the next Olympia Camera Club Field Trip and we will 
be focusing (pun intended) on macro photography. Bring a macro 
lens, extension tubes, or whatever close-up lens of choice. If you 
have a flash or diffuser or any other equipment you use for macro 
photography, bring it along. The wildflowers are blooming and we 
will have ample opportunities to photograph several species and to 

learn some wild-
flower identifi-
cation. 
We will meet at 
the old El Sarape 
parking lot on 
Cooper Point 
Road near Wild Birds Unlimited at 8:00 a.m. and plan to leave at 
8:15 a.m. and carpool to Mima Mounds. If you plan to drive to 
Mima Mounds, a Discover Pass is required. If you need to car-
pool with someone who has a Discover Pass, there will be car-
pool opportunities when we meet. 

FIELD TRIP COORDINATOR  
 
As mentioned last month, Kay and I will provide a cur-
rent list of planned/potential upcoming field trips.   To 
make this article more informative, if you have previous-
ly visited one or more of these field trip sites, we are re-
questing photos that could be shared in the Newsletter.  I 
would suggest placing copyrights/watermarks in your im-
ages.  Kay and I are relatively new to the Olympia area, 
and have yet to visit many of these field trip locations.  
We appreciate any photos you might send to the OCC 
Dropbox or to my email address:  nor-
man.ott63k@gmail.com.  Use will be restricted to the 
OCC Newsletter. 
 July thru December is still a bit sketchy.  The Field Trip 
Committee will meet in May to look at best times for po-
tential trips and to fill the schedule for the rest of 2017.   
    
2017 Field Trips:    
 
Planned: 
20 May Mima Mounds  led by Bruce Livingston 
June  Lewis River Falls  
July  not yet scheduled 
Aug  not yet scheduled 
Sep  Olympic Peninsula (area not specified) 
Oct  not yet scheduled 
Nov  not yet scheduled 
Dec  not yet scheduled 
 

Potential trips (no dates planned): 
Dosewallips State Park 
Mt. Saint Helens 
Hurricane Ridge 
Chuckanut Drive (along old State Hwy 11 - Burlington to 
Fairhaven) 
Ft. Casey/ Ft. Worden (park in Port Townsend... take fer-
ry to Ft. Casey) 
Olympic Peninsula - Juan de Fuca Highway (State Hwy 
112) Clallam Bay to Neah Bay.   Potential to com-
plete loop and return via Hwy 101) 
Olympia Yashiro Japanese Garden w/reflectors 
Portland Tour (overnight) 
Palouse (+/- Adam County scenery) (overnight) 
Leavenworth, WA (with option to watch Sound of Music 
Stage Pacific Science Center - Terra Cotta Warriors Ex-
hibit (See article for information) 
 
Comments or suggestions concerning this effort to im-
prove the Newsletter are welcome and encouraged. 
Norm and Kay Ott 
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Create a Watermark in Lightroom 

by Pam Hoaglund 

1. On PC select “Edit” > “edit watermark”. On MAC select “Menu” > “edit watermarks”. 
2. The following dialog box will open: 
 

 
3. Choose type of watermark you want, text or graphic. 
4. Enter your watermark text in the text field beneath the preview image: example Happy Snapper. 

  
5. To add © copyright symbol, hold down ALT while typing 0169 on the number pad (Windows) or type OPT-G 

(MAC) 
6. Apply options in the options menu; font, style, color, etc. You can see what your watermark looks like in the 

preview image. 
7. Click Save and give your watermark an original name. 

      Your watermark will be applied to your image when you export it by selecting Watermarking in the export dia-
log box. 
 

(Continued on page 8) 
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(Continued from page 7) 

Watermarking with Photoshop Elements and Photoshop 

by Rosalind Philips 

The goal here is to make a brush that you can use for your watermark. Once you have created the brush, you can use 
it over and over again. The instructions are the same for Photoshop and Photoshop Elements. The pictures below are 
from Elements. 

1. Open the editor.  Select Expert mode. 
2. Choose File -> New -> Blank File. 
3. Fill in the file specifications as below. Note that the resolution is 72 because this watermark is for pictures to be 

displayed on the web. If you are printing, increase the resolution to 300. 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

(Continued on page 9) 
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4. Click OK. 
5. Click on the Horizontal Text tool. Choose a font that you like. Set the font size to 125 and start typing. Use alt 

0196(PC) or Option G (Mac) to get the copyright symbol.  © 
6. Your screen should look something like this. 
 
 

 
 
 
 
 
 
 
 
    You want to make it so that your watermark takes up the entire space. 
7. Type B to select the brush tool. Click the arrow next to the brush and check that default brush is selected. 

 
 

8. Choose Edit -> Define Brush. Choose a name for your brush. Note the number 977 in the lower left corner. 

That is the number your brush will have in the dropdown menu. 977 is the width of the brush. If you hold 

your cursor over the brush, you will see the name watermark. 

 

 

 

 

 
 
 
 

(Continued from page 8) 

(Continued on page 10) 
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9. One more step. Click on the down arrow again to get the brush menu and click on the parallel lines next to the 

default brushes.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
     Click Save Brush and you are done creating the watermark. Close the file you created your brush with. You do 

not need to save it. 
10. Open an image to use your watermark brush. 
11. Select the brush tool. Since you just made your brush it should already be selected from the list of default 

brushes. You will notice that the watermark is way too big. We made it big because it’s easier to shrink the 
brushes than to make them larger. 

12. Next make a new layer by going to Window -> Layers. Click on the circled icon in the image below to make 
a new layer. 
 
 

 
 
 
 
 
 

(Continued from page 9) 

(Continued on page 11) 
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13. Make sure that Layer 1 is selected and click anywhere on your image with your brush. Your watermark 
should look something like this: 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
14. Click on the move tool. Then select Image -> Transform -> Free Transform. Hold down the shift key 

and drag the bottom right corner handle to size the watermark. Holding the shift key down keeps everything 
proportional. 

 
 

15. After you size it, move the watermark to your preferred location and you are done. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(Continued from page 10) 

(Continued on page 12) 
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Some tips 
Change the color of your brush before you click to place it on your image. 
You can freehand your signature instead of using a type font. Use a thin brush to sign your name. 
Lower the opacity so that the watermark does not distract from the image. 
You can also make your brush the size that you will usually use. Try using 250 as the width. 
 

     Here are four references with videos and written directions. The bottom two are for Photoshop. There are lots of  
     videos on YouTube, so check some out. 
 

http://www.theblogmaven.com/watermark-photos-photoshop-elements/ 

        http://www.essential-photoshop-elements.com/watermark-brush.html 
        https://www.youtube.com/watch?v=Rm4shqwDUTo 

       http://www.photographymad.com/pages/view/how-to-add-a-watermark-to-an-image-in-photoshop 

(Continued from page 11) 

My Bicycling Adventures on the Chehalis 
Western Trail (CWT) 
 
by Neil Harris 

 

We moved to Lacey Christmas of 2012 in a neighborhood 
very close to the Chehalis Western Trail (CWT); the 
house is about two short city blocks away. Being close to 
the trail was a very important key in our moving. 
In the past when I lived in Rochester (25 miles south of 
Lacey) I transported my bike using my pickup truck to 
Tenino where a junction of the CWT started and I would 
ride to Yelm or sometimes up the CWT towards Lacey. 
So far you get the idea I like riding on the CWT; anyway, 
if you’re like me and don’t like to ride in traffic the trail 
is an ideal place. 
Two years ago I decided to upgrade from a bridge camera 
to an enthusiast level DSLR the Nikon D7100, which, 
with an 18-300 lens works just fine for me.  
I try to ride 6 to 15 miles a day throughout the year. Most 
rainy days there is at least a period of an hour when the 
rain stops. Most of the time I make it without getting wet 
and then sometimes I come home with rain soaked pants. 
While I’m riding I’m either listening to a novel or some-
times listening to a Basic Spanish Tutorial. So if you see 
me talking to myself 
I’m actually repeating 
Spanish phrases.  
Along my three differ-
ent CWT routes I have 
plenty of photo oppor-
tunities. Sometimes I 
stop to take photos and 
sometimes I ride on. 
As the seasons change 
the trail continually 
changes or weather 

conditions change. Between the fog, rain droplets, leaves 
changing color, small ponds with ducks, seasonal flowers 
and trees or just debris on the trail, there is always some-
thing to take photos of. 
 

 
 
 
 
 

http://www.theblogmaven.com/watermark-photos-photoshop-elements/
http://www.essential-photoshop-elements.com/watermark-brush.html
https://www.youtube.com/watch?v=Rm4shqwDUTo
http://www.photographymad.com/pages/view/how-to-add-a-watermark-to-an-image-in-photoshop
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LIFE Formula for Photo Storytelling 
 
Submitted by David Frinell 

 
Recently I read the 2017 Evergreen College summer class 
catalog.  I noted the course heading- "Fundamentals of 
Photojournalism”, which tweaked my curiosity.  The 
course description stated: “Weekly assignments will be 
based on the LIFE Formula for Visual Variety in the Pho-
to Story, with focus on image content and visual storytell-
ing."  I googled, "Life Formula for Visual Variety in the 
Photo Story" and discovered numerous interesting articles 
describing a photojournalistic method used by Time Mag-
azine.   
Below is a description of the method they used to obtain 
the necessary photographs to cover any Life Magazine 
photo essay. 
  
1] Introductory or overall – usually a wide angle or aerial 
shot that establishes the scene. 
 
2] Medium – focuses on one activity or one group. 
 
3] Close Up – zeroes in on one element, like a person’s 
hands or an intricate detail of a building. 
 
4] Portrait – usually either a dramatic, tight head shot or a 
person in his or her environmental setting. 
 
5] Interaction – people conversing or in action. 
 
6] Signature – summarizes the situation with all the key 
story telling elements in one photo – often called the deci-
sive moment. 
 
7] Sequence – a how-to, before and after, or a series with 
a beginning, middle and end (the sequence gives the es-
say a sense of action). 
 
8] Clincher – a closer that would end the story. 
 
HERE IS ANOTHER GOOGLED ARTICLE ON THE 
SUBJECT 
 
Moving through the next few steps in The Passionate 
Photographer, you’ll learn to work your scenes and give 

yourself options from all the elements below, a shortened 
structure of the classic Life magazine photo essays. 
 
Signature Image: This is often the strongest image, with 
visual impact that both tells a story itself, and invites the 
viewer into the story for further investigation. It’s the 
book cover, the storefront window display, the icon, and 
web page attention getter. We strive to make every image 
a signature image but in the end, it rises to the top from 
the following visual possible components that make up 
your essay. 
 
Portrait: A picture of a key player in the story you are 
photographing. Make sure to use background and/or fore-
ground elements to help bolster the narrative. 
Environmental portraits, where the subject is caught in a 
real moment, can be very compelling, but so too can a 
series of posed portraits. 
 
The Overall or Wide View: This photograph gives us a 
sense of the place or a part of the place where your story 
happens. Note that sometimes a sense of place can be 
communicated in a series of detail images. 
 
The Detail: Look for a photograph that examines details 
rather than the larger picture. This photograph can often 
be abstract and particularly eye-catching, a nuance. This 
detail also can reveal to the viewer something that would 
otherwise be missed in a wider shot. A series of small de-
tails can be used as a mosaic in one image. 
 
The Action: Show us what is going on in your story. 
Look for dramatic and poignant images capturing people 
interacting with each other, moments and gestures that 
elevate and amplify the visual communication in some 
way. 
 
I hope you are as interested as I was to learn more about 
this method of Photojournalism and try to utilize it in 
your photographic storytelling.  Maybe you will create a 
photographic story of a trip, or other event following 
these suggestions and share it with the Olympia Camera 
Club.   
 
Cheers, David Frinell, member of the Olympia Camera 
Club, Olympia, Washington 
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The RGB Histogram 

by Pam Hoaglund 

 

Now that Spring is here and we are all excited to get out and photograph all the blooming flowers it’s important to 
understand the RGB (red, green, blue) histogram. Have you ever photographed a field of red flowers such as tulips 
and when you got home and looked at the images you found the reds had no detail and the flowers looked washed 
out? You say to yourself “I looked at the histogram and it looked good, what went wrong?”  
Most digital cameras have two histograms; the averaging histogram which shows the average of the red, green and 
blue channels and the RGB histogram which shows the three channels individually. When photographing a field of 
red flowers such as tulips it’s important to base your exposure on the RGB histogram.  
As you can see in the example below the averaging histogram looks like the exposure will be good but if you look at 
the RGB histogram you can clearly see that the red channel is spiking up the right side of the graph indicating that 
some detail is lost in the reds. 
 

 
 
 
 
 
 
 
 
 
 
 
 
In the example below exposure compensation has been used to decrease the exposure and thus keeping the red chan-
nel from spiking and losing detail in the reds. 
 

 

 

 

 

 

 

 

 

  

http://www.earthboundlight.com/phototips/red-flowers-red-blobs.html 

The following link is an excellent reference on how to photograph wildflowers. 

http://www.naturemagazin.com/wildflowers-photography-tips-tricks/ 

http://www.earthboundlight.com/phototips/red-flowers-red-blobs.html
http://www.naturemagazin.com/wildflowers-photography-tips-tricks/
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Member Gallery 
Billy Frank Jr. Nisqually NWR 

 
Images by members Tammy Mandeville and Judy Cheley 
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A "Must See" Opportunity to Photograph the Qin Dynasty Terracotta Warriors  
and other Marvels from Ancient China.   

 
Where:  Pacific Science Center, Seattle 
When:  Now through September 4th, 2017 
 
Cost:     Regular Price - Adults $32.75,  Seniors (65+) $30.75 
              Groups of 10 or more:  Adults $26.20,  Seniors $24.60 
             (AAA members get 10% off regular admission fee) 
 
 
     by Norm Ott 
 
Kay and I visited this outstanding cultural display in Frankfurt, Germany a 
few years ago.  It was fascinating, and gave us a very inexpensive chance to view some of these ancient terracotta fig-
ures, without the considerable expense of a trip into China.  We wanted to make everyone aware of this opportunity, 
and if enough folks are interested, we could get a group together and qualify for the reduced entrance fees. 
 
We took many notes during our visit in Frankfurt, and have provided the following information concerning Emperor 
Qin Shi Huang, his rise to power and accomplishments, and the enormity of manpower needed to build his mausole-
um and the terracotta army.   
 
I hope you enjoy reading a bit of his history, viewing a few pictures from our previous visit, and hopefully make 
plans to join us for a trip to the Pacific Science Center. 
 
The Qin Dynasty 
 
Everyone in China knows Qin Shi Huang Di, even though his rule dates back more than 
2000 years.  His strategic genius is still of deep interest to generals of today.  Politicians 
are still studying his political successes and failures. 
     
He was born as Ying (family name) Zheng (first name). His year of birth, 259 b.c., co-
incides with the final phase of the “Hostile States,” i.e. the seven sovereign states of Qi, 
Chu, Yan, Han, Zhao, Wei, and Qin, which were entangled in a bitter struggle for pre-
dominance lasting over 200 years.   
 
His father, Zi Chu, was the son of Prince Qin An and the grandson of King Qin Zhao.   
Zi Chu was the son of one of Qin An’s minor wives, and as such, he was sent to the 
kingdom of Zhao as a hostage. To display good will it was customary that a member of the reigning family was used 
as a guarantor of promises given. 
      
After Zi Chu had managed to return to Qin, it did not take him long to be crowned king.  He 
ruled under the name of Zhuang Xuang, and his son Ying Zhen was given the official title of 
Crown Prince.  Upon his father's death in 246 b.c., Ying Zheng was proclaimed the new king 
at the age of thirteen.  As it would have been impossible for a boy of his age to comprehend 
the constantly changing alliances and aggressive situations of the Seven States, Lu Buwei, as 
Chancellor, together with Lao’ai, the favorite of the Queen Mother, ruled on his behalf.  
Within ten years he ended the chaos of war among the “Hostile States.”  After uniting the 
state, he adopted the name Shi Huang Di. 
 
In 238 b.c., at the age of 22, Ying Zheng wielded the scepter himself.  The dictatorship of Lu 
Buwei and Lao’ai had long been a thorn in his flesh.  Therefore, he had Lao’ai executed, his 
mother imprisoned, and Lu Buwei expelled from office.  He then established an advisory 
panel and, following their advice. 

(Continued on page 17) 
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Ying Zheng reinstated his father’s reform policies and declared the tilling of fields 
and the uncompromising pursuit of combat duties to be of the highest virtue.  In this 
way the Kingdom of Qin rose to new heights and soon became predominant among 
the seven “Hostile States.” 
 
United by Force 
 
By 221 b.c., the young king succeeded, by clever alliances and aggression, in ruling 
over all the states in the immediate vicinity.  China thus became united, and the de-
structive aggression among the states themselves came to an end.  This marked the 
birth of the first empire in Chinese history.  
     
 After uniting the state, Ying Zheng felt entitled to bear the name “Huang Di,” which means King of Kings or Emper-
or.  He went down in history under the name of “Shi Huand Di” (First Emperor).  All rulers succeeding him bore the 
title “Huangdi”, and this remained the form of address for the Son of Heaven until the monarchy was abolished in 
1911. 
      
To fortify his kingdom’s central power, Qin Shi Huang Di abolished feudalism, which had existed since the Shang 
and Zhou dynasties.  It was replaced by an administrative system with districts and urban and rural zones.  The entire 
country was divided into 36 districts.  Shi Huang Di’s most important reforms for the economic development of the 
country included the standardization of weights and measures, the alphabet, characters and spelling, and currency. 
     
A further important measure was the construction of roads of standardized width, 
as well as connecting sections of the defensive walls once erected by the Hostile 
States.  The result was the “Great Wall”, which reached from Lintao in the West to 
the Shanhai Passage in the East and is said to extend 10000 Li. 
 
Decline of the Dynasty 
      
During an inspection trip in 210 b.c., Qin Shi Huang Di died in present-day Guang-
zong, Hebei Province).  He was fifty years old.  Following his death, his second, 
incompetent son, Hu Hai, falsified the imperial edict regulating the order of succes-
sion.  He killed his elder brother, Fu Su, and claimed the throne.  At Qin Shi Huang 
Di’s death, the Qin Dynasty was faced with decline.  Soon thereafter, a nation-wide 
peasants’ revolt broke out and the Qin Dynasty collapsed.  
      
Three chief causes can be cited for the collapse of the Qin Dynasty: cruel laws and abuse of penalties, forced collec-
tion of taxes and slave labor for gigantic construction works, and, finally, the utter incompetence of Hu Hai as a ruler. 
     
At the height of the construction activities, 700,000 men were working at the burial 
site.  Expenditure of manpower and funds was higher than that required for the Che-
ops Pyramid, beginning with his accession to the throng in 246 b.c., and taking 38 
years to complete. 
 
 For the construction projects ordered by Shi Huang Di in the ten years following 
unification, including connecting sections of the “Great Wall” and the further com-
pletion of his tomb, a total of two million slave laborers were required.  This num-
ber, in addition to those slaves called to other tasks, accounted for almost one tenth 
of the entire population.  They were mostly the young and strong whose manpower, 
essential to improve the country’s economy, was not available to other commit-
ments, thus persistently weakening the state.  And the enormous tax burdens did their part to stifle economic develop-

(Continued from page 16) 

(Continued on page 18) 
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ment and drive the people to revolt. 
 
Discovery and Archaeology 
 
In the early spring of 1974, villagers of Xiyang in Shaanxi Province decided to dig a new well.  During their excava-
tion work, they hit a layer of hardened red-brown clay.  Their pickaxes suddenly revealed grotesquely shaped frag-
ments of clay.  Their finds were the armored breast and back pieces of a 
clay warrior.  The head, as well as the arms and legs soon followed, and 
finally a bronze crossbow, arrows, and bricks were brought to light. 
      
The news of the finds spread rapidly to Beijing.  A team of archaeologists 
carried out excavations and proved that it was a vast collection of clay war-
riors and clay horses and that it was a part of the burial site of Shi Huang 
Di. 
     
The excavation of the clay army caused a sensation throughout the world.  
Since its discovery in 1974 to this day, a constantly growing number of 
domestic and foreign tourists have come to visit it.  The burial site is the 
only site in China listed as a UNESCO World Cultural Heritage. 
 
May 3, 2017 
 

(Continued from page 17) 

 



 

Page 19 - Volume 82, Issue 5, May 2017  

Taking Good Travel Pictures 
 

by Pam Hoaglund 

 

After a long wet winter and spring it is good to see the 
calendar turn to May and the anticipation of warm weath-
er and travel. Here are a few things to think about when 
you go out shooting: 
 
Use a tripod 
Shoot RAW 
Shoot Aperture priority 
Know your cameras metering modes 
Check the histogram (especially RGB) 
Use “Live View” 
Patrol the borders (look around the border of your image 
for unwanted intrusions) 
Change angles, try different compositions 
Use people for interest and perspective 
Fill the frame, move in close or zoom into scene 
Use wide angle for landscapes but don’t forget zoom 
lenses work well also 
Try panoramas 
Shoot at night, cities and astrophotography 
Try HDR for high contrast scenes 

Try silhouettes at sunrise and sunset 
Use an aperture of f/16 – f/22 to create star effect from 
sun, lights at night, or other light sources 
Try higher ISO to get faster shutter speed to stop motion 
or try Shutter priority 
Take pictures of signs, landmarks, and things to help you 
ID images when you get home 
Use your phone camera 
KEEP NOTES  
 
 

Grand Champion Winner – Puyallup Spring Fair 
 

Ellie Bellamy is a young lady who has recently joined the club along with her father. She entered several photos in 
the Puyallup Spring Fair and was a winner in the 11-15 year old class. 
CONGRATULATIONS ELLIE!! 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

OCC member Jack Cornwell’s grandson also won several ribbons at the fair. 
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Member profile 
 
Linda Foss  
 
What or who brought you to the club? 
I initially joined the club to learn about photography after 
buying a DSLR that I had trouble figuring out.  I had a 
film camera and had taken pictures for years on auto.  I 
soon realized I really did not know anything about pho-
tography. 
How did you get interested in photography? 
My interest in photography was two-fold. I get bored eas-
ily if I am not learning something new and I wanted to 
find a hobby that would follow me into retirement.  I am 
still learning and I retired last December.  
What kind of photography do you like to do? 
I like to photograph landscapes. My father was a geolo-
gist and my grandfather had collected rocks. He made 
jewelry and books ends out of petrified wood which he 
sold through Wall Drug in Wall, South Dakota.   Our 
family vacations were usually in a National Park with our 
tent camper.   I have continued to travel to National Parks 
and love taking pictures of rocks and I usually study the 
geology before going or have a reference book with me.  
What equipment is in your camera bag? 
I have an array of Pentax/Ricoh DSLRs. I just added a 
Pentax K1 full format camera and am once again figuring 
out the new functions of this camera.  The only difference 
now is I have YouTube and Creative Live to help me 
learn.  I also have a Sony mirrorless camera and lens and 
a G-12 Canon.  
What post processing programs do you use? 
I use Photoshop CC for processing and Lightroom for 
organizing.  I use other programs such as Nik, Topaz, and 
Landscape Pro. 
What do you want to learn from the club?  
I have learned how to assess my own photographs criti-
cally with help of club members. I love the dialogue and 
the willingness of others to share.  I came to the club to 
learn and I feel that 
have made friends that 
are fun to be with.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

New Member Profile 
 
Ellie Bellamy 
 
My name is Ellie Bellamy and I just turned 13 this month.  
I have been going to the Olympia Camera Club, since 
March of this year. I love photography and recently won 
Grand Champion (11-15 yr old category) at the 2017 
Puyallup Spring Fair for my photo of my little sister. I 
look forward to learning more about cameras and photog-
raphy, so that I can take even better pictures.  
Below are the New Member Profile questions you gave 
me. 
What or who brought you to the club? 
 My dad (Dave) brings me to the club meetings... 
How did you get interested on photography? 
 Nothing really inspired me; I have just been interested in 
photography since I was 3! 
What kind of photography do you like to do? 
 I'm really interested in taking nature & portrait photos. 
What equipment is in your camera bag? 
 In my bag, I have a macro lens, tripod, and my dad's 
camera - Nikon D3100.  I also have a Fujifilm digital 
camera. 
What post processing programs do you use? 
 I use the photo editor that is automatically installed onto 
my phone, I don't really need to crop things that often, 
and so I just use saturation and contrast on the photo. 
What do you want to learn from the club? 
 I would really like to learn more about cameras and pho-
tography and how to use the tools. 
 
Here is a selfie of me I took with the Nikon and a duck 

picture I took at 
Lake Crescent: 
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Annual Olympia Camera Club Banquet 
 

Coordinator Linda Foss 

 

 June 27, 2017 at 6:00 PM at the River’s Edge Restaurant.  
 

Our annual banquet is coming up in June. An adult and children’s menu is provided below. Please select your menu 
choice and send your selection to fossl7284@gmail.com by June 15, 2017.   This provides time for the restaurant to 
order food to ensure that they can meet our needs.     If you have any questions please do not hesitate to ask. 
          
 

mailto:fossl7284@gmail.com
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Olympic Air Show 
 

Father’s Day Weekend 
 

June 17-18, 2017 
 

Summer is here and one of the big weekend events in Olympia is the Olympic Air Show.   This is the 19th annual 
show.  It has been a long tradition that the Olympia Camera Club members have photographed the event for the mu-
seum.  The photographs are used each year to advertise and promote the museum and next year’s show.  Volunteer 
Photographers will receive a free pass for both days of the show in return for taking the photographs.  Please let me 
know if you are interested in being a volunteer this year.  My email address is fossl7284@gmail.com.  
 
 

THURSTON COUNTY FAIR - AUGUST 2-6 
by Dale Easley 

 

VOLUNTEERS NEEDED 

It’s time to start thinking about the Thurston County Fair coming up in August.  Our club is the sponsor of the Open Photography 

Exhibit, and club volunteers are needed to make it successful.  Help is needed to take in prints on Saturday, July 29th, assist with 

judging on Sunday, July 30th, and hanging the prints on Monday, July 31st. 

 

Club members will also man an information desk on Wednesday, August 2nd through Sunday, August 6th from 10 a.m. to 10 

p.m. each day.  I’ve set up a schedule that puts 2 people on 3 hour shifts throughout the day.  Those volunteering for these shifts 

will receive free admission to the fair and can come early or stay after their shift to enjoy the fair. 

 

I’m also looking for one or two people to build an educational display board about photography to add to our exhibit.  For more 

details, please talk to me personally if you’re interested. 

 

Volunteer sign up forms will be passed around at each meeting this month. 

 

ENTERING YOUR PRINTS 

It’s also time to start flagging those special images that may be candidates for entry into the photo exhibit.  Complete entry in-

structions and the entry form may be downloaded at: http://www.olympiacameraclub.org/thurston-county-fair/ 

 

mailto:fossl7284@gmail.com
http://www.olympiacameraclub.org/thurston-county-fair/
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The Canola Bloom on the Palouse  
 

by Linda Foss  

 

My first photography tour was to the Palouse in May 2010.  A photograph in a magazine of green rolling hills caught 
my eye. I was delighted to find the location less than a day’s drive from my front door. I have continued to visit and 
photograph the area.  I just love driving the roads and enjoying the geology and the beauty of the crops grown on the 
hills.  The sky is always changing.  In addition, everyone you meet is nice. 
 The short story was the rolling hills were created by a massive flood when the Glacial Lake Missoula ice dams would 
break. The cataclysmic floods swept across eastern Washington carving out the rolling hills and plateaus that photog-

raphers visit today (Roadside Geology of WA)  
I was fortunate to meet Jack Lien through the OCC on a weekend field trip.  
He is a photographer who lives and works in the Palouse.  Last August, I 
was a participant in Jack’s workshop.  His knowledge of photography and 
love for this land shows in his passion for teaching.  Jack also knows every 
farmer and the location of every barn and old car.  I am going back this 
June to photograph the color of the canola in bloom.  According to Jack, 
the farmers have planted 50% more fields of canola this year.  I wanted to 
share my thoughts of the Palouse and several pictures to inspire you to visit 
this magical setting in Washington. 
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The 2017 Annual Scavenger Hunt and Banquet 

 
by Rosalind Philips 

 

Here Ye, Here Ye. The annual Scavenger Hunt and Banquet of the Olympia Camera Club will be held on June 27th. 
Now is the time to start working on the list. Some of the words are challenging; I have confidence you will all have 
great ideas for images. See you at the banquet. 
2017 Olympia Camera Club Official Scavenger Hunt Rules 
This year, members will have two ways to participate in the Banquet Slide Show entertainment. 

Submit one image for each of the 15 words below. You many take as many images as you like and do as much 
processing as you like, but you can only submit one image for each word. Please note that some of the words 
are from the 52-week challenge list. You may submit images that you have already posted for the challenge. 

OR 
Submit 10-15 of your favorite/best images taken between 6/1/2016 and 6/13/2017. You may do as much pro-

cessing as you like on the images. 
Rules 

All images must be JPEGS – no RAW or TIFF images. 
The images must not exceed 1024 pixels in width or 768 pixels in height. The resolution should not exceed 72 

dpi. 
Scavenger Hunt Images. Name your images as Sxx_Name_word.jpg where 

S means scavenger hunt, xx is the number of the word and word is the category. For example, an image 
submitted for the 5th word “Plaid” would be named S05_RosalindPhilips_Plaid.jpg.  

Please include a list of your images with descriptions.  
Favorite/Best of 2016-17 images. Name your images as Bxx_Name_ImageName.jpg .  

B means Favorite/Best of 2016-17, xx is the number of the image, Name is your name and ImageName is 
the name of the image. For example the eighth image I submit would be named, 
B08_RosalindPhilips_BergyBit.jpg. 

Please include a self Identification Image as your 16th image. 
Please burn your images to a CD, DVD or thumb drive. 
Images are due no later than Tuesday, June 13, 2017 at the Fundamentals Meeting. You can bring your images to 

the meeting or mail them to Rosalind Philips, 4643 Indian Summer Dr SE; Olympia WA, 98513. 
We will watch the two slide shows at the Banquet on June 27th. Please contact Rosalind at 

RosalindPhilips@comcast.net or at 360-790-2814 with any questions 
(Continued on page 26) 

 

mailto:RosalindPhilips@comcast.net
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2017 Scavenger Hunt List 

 
One of our members requested that the scavenger hunt words be posted earlier in the year so there is more time to 
hunt for them. So here is the list. Images are due on June 13th at Fundamentals Group. There will be an article in the 
April newsletter with more details. The information has been updated on our web page. Please contact Rosalind 
Philips with any questions. 
 

(Continued from page 25) 

Num Category 

01 insect 

02 rain 

03 toys 

04 spring 

05 reflections 

06 shadows 

07 cars 

08 purple 

09 even 

10 joy 

11 pets 

12 misty 

13 green 

14 shoes 

15 noise 

16 Self Identification 

Membership Report 
 

by Colleen Easley  

 
This month we welcome 7 new members. 

 

Dave Belamy 

Ellie Belamy 

Sylvia Cornette 

William Cornette 

Laura Johnsen 

Fern Sullivan 

Kristi Weis 

 

We now have a total of 137 members.  This includes 1 gift membership and 6 honorary memberships. 

 

Please offer a warm welcome to these folks if you have a chance to meet them at upcoming meetings. 
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Olympia Camera Club Board Minutes   
   DRAFT 
May 2, 2017 @ 6:30 p.m. 
Casa Mia Restaurant, Olympia 
 
Officers and Members Present 
Bruce Livingston, Scott Wood, Meredith Rafferty, John 
Damitio, Pam Hoaglund, Norm and Kay Ott, Dale and 
Colleen Easley, Rosalind Phillips, John Gerecht, and Lin-
da Foss. 
  
Meeting called to order at 6:30 p.m. by President Bruce 
Livingston. 
 
Minutes 
A motion was made by Rosalind Phillips to approve the 
April 2017 minutes. MSC (Moved Seconded Carried) 
Unanimous. 
 
Treasurer’s Report 
John Damitio reviewed the Treasurer’s report.  Unani-
mous to accept the report. 

 

Membership 
Colleen Easley reported 137 members.  Six of those are 
new members this past month. 
 
President’s Report 
Bruce Livingston summarized the recent Bottle Beach 
field trip which 25 people attended.  Attendees were re-
minded of the opportunity to share photos through Flickr 
and Facebook and to submit them for use in Club newslet-
ters. 
 
Historian and Community Liaison 
Linda Foss stated that volunteers are requested to photo-

graph the Olympic Air Show on June 17.  She will discuss 
at the Club meeting. 
 
General Meeting topics 
Scott Wood explained May’s topic, a discussion of the 
photography competition hosted by the Club at the 
Thurston County Fair, explaining the goals of the Club’s 
sponsorship and encouraging participation. 
 
Advanced Group 
Scott Wood discussed the scheduled topic of what is 
“critique”, exploring what is a good image and what to 
consider in evaluating your image.  People are invited to 
bring their images. 
 
Fundamentals Group 
The topic for May will be applying photography concepts, 
as shared by several members for different subject matter. 
 
Digital Imaging Group 
John Gerecht has scheduled a discussion of printing and 
mounting your images. 
 
Equipment 
Rosalind Phillips led a discussion of purchasing a new 
projector to improve the color and resolution of the 
Club’s frequent presentations and present the quality of 
people’s images.  Bruce Livingston asked Rosalind and 
Scott Wood for options and prices for the Board to con-
sider. 
  
Newsletter 
Pam Hoaglund asked for continued ideas and images for 
the newsletter.  Members are encouraged to submit short 
write-ups of photographic opportunities, events and plac-
es and accompany them with their images or to submit 
other images which she can share as general content.  
Newsletter deadline is May 4. 
 
Webmaster 
Colleen Easley reviewed activities with the website and 
the website’s calendar.  She noted that the signup sheet 
for field trips is on the website. 
 
Field Trips 
The May 20th field trip will be a macro photo opportunity 
at Mima Mounds. Norm and Kay Ott discussed ideas for 
future field trips.  They will work with the committee to 
finalize a schedule. 
 
Northwest Council of Camera Clubs (NWCCC) 
Bruce Livingston shared that OCC’s volunteer role with 
November’s conference will be to arrange vendors’ par-
ticipation. 

(Continued on page 28) 
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NWCCC Traveling Prints Competition 
The circuit for the review of traveling prints will be com-
pleted in June, as Dale Easley reported.  Finalists will 
continue to the final judging at November’s NWCCC 
Conference.  
 
Nature Photographers of the Pacific NW (NPPNW) 
No new information. 
 
Photographic Society of America (PSA)  
No new information. 
 
Thurston County Fair Photography Competition 
Dale and Colleen Easley reported that they have started 
preparations for this year’s Fair.  Dale discussed getting 
information on the website and requesting Club volun-
teers to carry out the competition. 
 
Old Business 

Use of “Meetup” website – Bruce Livingston explained 
that he will prepare a survey of members with the results 
to be discussed at the annual planning picnic. 
 
New Business 
Honorary Memberships – The Board had discussed pre-
viously that criteria should be developed for the awarding 
of Honorary Memberships.  Meredith Rafferty moved that 
she will take the lead to develop some options with others 
encouraged to bring their ideas, for the Board’s considera-
tion.  MSC 
 
Nominating Committee – In preparation for the Club’s 
annual election of officers, Bruce Livingston appointed a 
Nominating Committee.  Committee members are Bruce 
Livingston, Scott Wood, Rosalind Phillips and Linda 
Foss. 
 
MSC Unanimous to adjourn the meeting at 8:50 p.m.  
 
   Submitted by Secretary Meredith Rafferty 

(Continued from page 27) 

Get ON1 Effects 10.5 FREE. Normally costs $59.99.  

This can be used as a plug-in in Lightroom or Photoshop or a standalone. 

https://www.on1.com/promo/0517-effects/Get ON1  

 

 

https://www.on1.com/promo/0517-effects/Get%20ON1
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Photographic Society of America (PSA) 

 

PSA is a worldwide organization for anyone with an in-

terest in photography. Founded in 1934, the Society is for 

casual shutterbugs, serious amateurs, and professional 

photographers. 

Individual digital membership is $45 a year. 

Membership offers a wide variety of services and activi-

ties:  

1. Monthly Journal 

2. Online photo galleries 

3. Image evaluation 

4. Study groups and courses 

5. Competitions 

6. Annual Conference 

7. Discounts on photography-related products/services  

8. PSA travel aide 

For a complete overview of membership benefits go to 

www.psa-photo.org    

Dates to Remember 

8 May Digital Imaging 
9 May Fundamentals 
16 May Advanced Meeting 
17 May Koffee Klatch 
20 May Field Trip - Mima Mounds 
23 May General Meeting 
31 May Koffee Klatch 
 
17-18 June Air Show Thurston Co Airport 
27 June Annual Banquet 
 
2-6 August Thurston Co Fair 
 
4 November NPPNW meeting 
11 November NWCCC conference 

 
 
 
 
 
 

Sizing Images for Newsletter 
 

Mode: 8 bit 
Color profile: sRGB 
Format: jpeg, max quality 
Resolution: 300 pix/in 
Dimension: 1024 pix long side 
Please Watermark your image! 
 

All photographs in this newsletter are under copy-

right protection. They may not be used without per-

mission from the individual photographers. 

 

Please submit articles and photographs to: 

newsletter@olympiacameraclub.org 

Deadline for June newsletter is June 8th at midnight. 

 

 

http://www.psa-photo.org
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May 2017 

Olympia Camera Club Monthly Meetings 

Business Meeting 

Monthly on the First Tuesday of the Month 

Tuesday, May 2, 2017, from 6:30pm to 8:30pm 
Open to all. Join us before the meeting at 5:30pm  for dinner. 
 
Contact: Bruce Livingston, President 

The Fundamentals of Photography Group 

Monthly on the Second Tuesday of the Month 
 
Tuesday, May 9, 2017, from 7:00 pm to 9 pm 
Program: Application of basic skills when photographing cars, birds, flowers, dogs, 

cats and horses 

Contact: Judy Mason, Fundamentals Chair 

 

The Advanced Photographers Group (APG) 

Monthly on the Third Tuesday of the Month 
 
Tuesday, May 16, 2017 from 7pm to 9pm 

Program: We will discuss the elements of good photo critiquing & how it can help us grow as 

photographers 

Contact: Scott Wood, APG Chair 

General Meeting 

Monthly on the Fourth Tuesday of the Month 

Tuesday, May 23, 2017 from 7pm to 9pm 
Program: The club’s participation in the Thurston Co. Fair and  
everything you need to know about getting your images ready for the fair 
 
Contact: Scott Wood, Vice President 

Koffee Klatch Meet up, Every Other Wednesday Morning from 9am to 11am 

Panera’s Bakery, 2525 Capitol Mall Drive SW, Westside of Olympia 

 
Open discussion about photography and other topics of interest 
 

Contact: Linda Foss, Klatch Chair 
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Executive Committee 

President  

Bruce Livingston 
 

Vice President 

Scott Wood 

 

Secretary 

Meredith Rafferty   

 

Treasurer 

John Damitio 

 

Immediate  

Past President 

Rosalind Philips 

 

Newsletter Editor 

Pam Hoaglund 

Committee Chairs 

Community Liaison 
Linda Foss 
Equipment Custodian 
Rosalind Philips 
 
NWCCC Traveling Prints 
Dale Easley 
 
Field Trip Coordinator 
Norm Ott 
 
Membership 
Colleen Easley 
 
NPPNW Liaison 
Colleen Easley 
 
 
 
   
 
 
 
 
 
 
 
 

Advanced Photography Group 
Scott Wood 
 
Newsletter Editor 
Pam Hoaglund 
  
 
PSA Representative 
Pam Hoaglund 
 
Thurston County Fair  
Colleen and Dale Easley 
 
Historian 
Linda Foss 
 
Digital Imaging Group 
John Gerecht 
 
 
 

Olympia Camera Club 
P.O. Box 13333 

Olympia, WA 98508-3333 
 
 
 
 

Fundamentals of Photography 
Judy Mason 
  
NWCCC Liaison 
Frank Townsend 
 
Scavenger Hunt 
Rosalind Philips 
 
Webmaster 
Colleen Easley 
 
Social Committee  
Linda Pardee 
 

Associate Memberships 
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